[image: image1.png]The Meeting Transcript of
The Los Angeles County
Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




August 17, 2004


[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





           Adobe Acrobat Reader 5.0

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

       To find the next occurrence of the word: 

        Do one of the following:

        Choose Edit > Find Again 

        Reopen the find dialog box, and click Find Again.  (The word must already be in the         Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to the last letter.  

       To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

       To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  

2. Choose Edit > Copy to copy the selected text to the clipboard.

3. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[REPORT OF ACTION TAKEN IN CLOSED SESSION

ON AUGUST 17, 2004, BEGINS ON PAGE 50.]
SUP. KNABE, CHAIR: WE WILL BE LED IN THE INVOCATION BY THE REVEREND JONATHAN WU, OUTREACH PASTOR AT THE EVERGREEN BAPTIST CHURCH IN ROSEMEAD, FOLLOWED BY THE PLEDGE OF ALLEGIANCE WHICH WILL BE LED BY VICTOR APREA, VICE COMMANDER, 18TH DISTRICT, WEST COVINA POST NUMBER 790, THE AMERICAN LEGION. REVEREND WU? 

REVEREND JONATHAN WU: WOULD YOU JOIN ME IN PRAYER. OH, SOVEREIGN GOD, WE GIVE THANKS THIS DAY FOR THE BLESSING OF LIFE, FAITH, AND HOPE. LIFE TO SAVOR THE BEAUTY OF EACH MOMENT OF EVERY DAY, FAITH TO BELIEVE THAT OUR TOMORROWS WILL BE OF GREATER GOOD AND BENEFIT FOR ALL, AND HOPE TO SEE THE RADIANCE OF RIGHTEOUSNESS, JUSTICE, AND GRACE REST UPON OUR COMMUNITY AND OUR LAND. WE ASK FOR THE GIFTS OF DISCERNMENT, WISDOM, AND COURAGE FOR OUR SUPERVISORS AS THEY RECEIVE AND DELIBERATE ON THE MATTERS OF THIS GATHERING. WE, TOGETHER, RECOGNIZE THEIR CHARGE TO SEEK THE WELLBEING AND PEACE OF OUR COUNTY. MAY YOU GRANT THEM DIVINE POWER AND INSIGHT AS THEY STEWARD AND EXECUTE THEIR RESPONSIBILITIES. THIS DAY, WE PREPARE TO DO WHAT IS PLEASING IN YOUR SIGHT: TO ACT JUSTLY, TO LOVE MERCY, AND TO WALK HUMBLY. IN THE NAME OF THE ALMIGHTY WE PRAY. AMEN. 

VICE COMMANDER VICTOR APREA: WOULD YOU PLEASE FACE THE FLAG, PLACING YOUR RIGHT HAND OVER YOUR HEART, AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. [ PLEDGE OF ALLEGIANCE ] 

SUP. KNABE, CHAIR: IT'S MY PLEASURE TODAY TO PRESENT A CERTIFICATE OF APPRECIATION TO VICTOR APREA FOR LEADING US IN THE PLEDGE THIS MORNING. I'M DOING THIS ON BEHALF OF SUPERVISOR ANTONOVICH, WHO IS OUT OF THE COUNTRY. VICTOR SERVED AS A PRIVATE IN THE UNITED STATES ARMY AIR FORCE IN UNIT 2532 FROM 1944 TO 1945. HE RECEIVED THE ARMY GOOD CONDUCT MEDAL, THE WORLD WAR II VICTORY MEDAL, THE NATIONAL DEFENSE SERVICE MEDAL AND THE SHARPSHOOTER BADGE. VICTOR ATTENDED U.S.C. AND IS A RETIRED PRINCIPLE ADMINISTRATIVE ASSISTANT FOR THE CITY OF LOS ANGELES TRANSPORTATION DEPARTMENT. HE'S A FATHER OF TWO AND HAS RESIDED IN THE FIFTH DISTRICT FOR OVER 50 YEARS. SO WE WANT TO THANK VICTOR FOR TAKING THE TIME TO LEAD US IN THE PLEDGE AND PRESENT THIS CERTIFICATE OF APPRECIATION. [ APPLAUSE ] 

SUP. KNABE, CHAIR: SUPERVISOR MOLINA? 

SUP. MOLINA: THANK YOU, MR. CHAIRMAN. IT'S MY PLEASURE TO PRESENT A CERTIFICATE OF APPRECIATION TO REVEREND JONATHAN WU. FOR OVER 10 YEARS, REVEREND JONATHAN WU HAS SERVED AT THE EVERGREEN BAPTIST CHURCH IN ROSEMEAD AND CURRENTLY SERVES AS SENIOR ASSOCIATE PASTOR OVERSEEING COMMUNITY AND GLOBAL OUTREACH PROGRAMS. HIS MANY CIVIC CONTRIBUTIONS INCLUDE SERVING AS PRESIDENT OF THE NONPROFIT CATALYST LEADERSHIP CENTER AS WELL AS PARTICIPATING IN FOOD ASSISTANCE EFFORTS THROUGHOUT THE SAN GABRIEL VALLEY. REVEREND WU IS A GRADUATE OF WHEATON COLLEGE AND TRINITY EVANGELICAL DIVINITY SCHOOL AND IS CURRENTLY PURSUING HIS DOCTORAL DEGREE AT FULLER SEMINARY. HE HOSTED THE COMMUNITY MEETING THAT WE HAD THE OTHER DAY AT HIS VERY FINE CENTER AND WE WANT TO THANK HIM AND WE APPRECIATE HIM IN LEADING US IN OUR INVOCATION THIS MORNING. THANK YOU, SIR. [ APPLAUSE ] 

SUP. KNABE, CHAIR: OKAY. PROCEED WITH THE AGENDA. 

CLERK VARONA-LUKENS: THANK YOU, MR. CHAIRMAN. MEMBERS OF THE BOARD. WE'LL BEGIN ON PAGE 3. ON ITEM S-1, AS NOTED ON THE GREEN SHEET, THE DIRECTOR REQUESTS THAT THE ITEM SHOULD BE CONTINUED TO SEPTEMBER 21, 2004, AT 11:00 A.M. 

SUP. KNABE, CHAIR: SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D AND 2-D, AND I'D ALSO LIKE TO NOTE, ON 2-D, THAT INCLUDES THE C.I.O.'S RECOMMENDATIONS FOR MODIFICATIONS. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA, SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY. ON ITEM 1-H, THE DIRECTOR REQUESTS THAT THE ITEM BE REFERRED BACK TO THE AUTHORITY. 

SUP. KNABE, CHAIR: SO ORDERED. 

CLERK VARONA-LUKENS: AND ON ITEM 2-H, THAT ALSO INCLUDES THE C.I.O.'S RECOMMENDATIONS FOR MODIFICATION. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR BURKE, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT, ITEM 1-P. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 11. ON ITEM NUMBER 8, HOLD FOR MEMBERS OF THE PUBLIC, AND THE REST ARE BEFORE YOU. 

SUP. KNABE, CHAIR: ON THE REMAINDER, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ADMINISTRATIVE OFFICER, ITEMS 12 THROUGH 15. ON ITEM NUMBER 13, HOLD FOR SUPERVISOR YAROSLAVSKY. 

SUP. KNABE, CHAIR: OKAY. ON THE REMAINDER, MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

SUP. YAROSLAVSKY: WHAT NUMBER WAS THAT, PLEASE? 

SUP. KNABE, CHAIR: 13. 

SUP. YAROSLAVSKY: ARE YOU SURE? 

CLERK VARONA-LUKENS: THAT'S WHAT I WAS GIVEN. AGRICULTURE COMMISSIONER WEIGHTS AND MEASURES, ITEM NUMBER 16. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR BURKE, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AUDIT COMMITTEE, NUMBER 17. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA. THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: COMMUNITY DEVELOPMENT COMMISSION, ITEM 18. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: COUNTY COUNSEL, ITEMS 19 AND 20. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: HEALTH SERVICES... 

SUP. KNABE, CHAIR: EXCUSE ME. I THOUGHT I HAD A HOLD ON 19. 

CLERK VARONA-LUKENS: (OFF-MIKE). 

SUP. KNABE, CHAIR: OKAY. RECONSIDER. 19 SHOULD BE HELD. 

CLERK VARONA-LUKENS: OKAY. 

SUP. KNABE, CHAIR: ON ITEM 20, THEN, WE'LL HAVE THAT MOTION AND SECONDED WITHOUT OBJECTIONS. 

CLERK VARONA-LUKENS: OKAY. HEALTH SERVICES, ITEMS 21 THROUGH 30. I HAVE THE FOLLOWING REQUEST. ON ITEM NUMBER 22, HOLD FOR A MEMBER OF THE PUBLIC. ON ITEM 24 AND ON ITEM 29, HOLD FOR MEMBERS OF THE PUBLIC. 

SUP. KNABE, CHAIR: OKAY. ON THE REMAINDER, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PARKS AND RECREATION, ITEMS 31 THROUGH 33. 

SUP. KNABE, CHAIR: CHAIR WILL MOVE IT, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC LIBRARY, ITEMS 34 THROUGH 36. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: PUBLIC SOCIAL SERVICES. ON ITEM 37, HOLD FOR SUPERVISOR KNABE. PUBLIC WORKS, ITEMS 38 THROUGH 51. ON ITEM 39, AS NOTED ON THE GREEN SHEET, THE DIRECTOR REQUESTS THAT THE ITEM BE REFERRED BACK TO THE DEPARTMENT. ON ITEM 40, SUPERVISOR KNABE REQUESTS THAT THE ITEM BE CONTINUED ONE WEEK. AND THE REST ARE BEFORE YOU. 

SUP. KNABE, CHAIR: ON THE REMAINDER, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: REGISTRAR/RECORDER, COUNTY CLERK, ITEM 52. 

SUP. KNABE, CHAIR: CHAIR WILL MOVE IT, SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: SHERIFF, ITEMS 53 THROUGH 59. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: TREASURER AND TAX COLLECTOR, ITEM 60. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: MISCELLANEOUS COMMUNICATIONS, ITEMS 61 THROUGH 69. ON ITEM 68, THE REGISTRAR REQUESTS THAT THIS ITEM BE TAKEN OFF CALENDAR. 

SUP. KNABE, CHAIR: SO ORDERED. 

CLERK VARONA-LUKENS: AND THE REST ARE BEFORE YOU. 

SUP. KNABE, CHAIR: ON THE REMAINDER, MOVED BY SUPERVISOR MOLINA, SECONDED BY SUPERVISOR YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ORDINANCES FOR ADOPTION, ITEMS 70 THROUGH 72. FOR THE RECORD, ON ITEM 72, SUPERVISOR MOLINA VOTES "NO". 

SUP. KNABE, CHAIR: OKAY. ON ITEM 70, 71, MOVED BY SUPERVISOR BURKE, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. ON 72, MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE WITH SUPERVISOR MOLINA VOTING "NO". SO ORDERED. 

CLERK VARONA-LUKENS: SEPARATE MATTERS, ITEMS 73 THROUGH 75, AND I'LL READ THESE INTO THE RECORD. 73, "TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF GLENDALE UNIFIED SCHOOL DISTRICT 1997 GENERAL OBLIGATION BONDS, SERIES G, IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $21 MILLION." THAT ITEM IS BEFORE YOU. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: 74, "TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION PROVIDING FOR THE ISSUANCE AND SALE OF THE LOS ANGELES UNIFIED SCHOOL DISTRICT 2004/2005 TAX AND REVENUE ANTICIPATION NOTES IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $750 MILLION." THAT ITEM IS BEFORE YOU. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: AND 75, "TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT RESOLUTION AUTHORIZING THE ISSUANCE AND SALE OF LOS ANGELES UNIFIED SCHOOL DISTRICT GENERAL OBLIGATION BONDS, ELECTION 2004, SERIES A, IN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED $300 MILLION." 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: ON THE PUBLIC HEARING ITEMS, 76 AND 77, WE'LL HOLD THOSE FOR HEARING. MISCELLANEOUS, ADDITIONS TO THE AGENDA REQUESTED BY BOARD MEMBERS AND THE CHIEF ADMINISTRATIVE OFFICER, WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING, AS INDICATED ON THE GREEN SUPPLEMENTAL AGENDA. 78-A. 

SUP. KNABE, CHAIR: CHAIR WILL MOVE IT, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. 

CLERK VARONA-LUKENS: 78-B. 

SUP. KNABE, CHAIR: MOVED BY SUPERVISOR MOLINA, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGINS WITH SUPERVISORIAL DISTRICT NO. 1. 

SUP. KNABE, CHAIR: DO YOU HAVE ANYTHING? I'D JUST LIKE TO TAKE AS SORT OF, AS CHAIR, ONE THING OUT OF ORDER. I THINK THIS IS GOING TO AFFECT ALL DISTRICTS. I'M GOING TO ASK CAROL LANE, THE CHAIR OF THE COUNTY COMMISSION ON DISABILITIES AND THE 2004 TAINTER SCHOLARSHIP RECIPIENTS. EACH YEAR ABOUT THIS TIME, MY COLLEAGUES AND I GET TO MEET WITH SOME EXCEPTIONAL YOUNG MEN AND WOMEN FROM OUR COMMUNITIES, AND THESE ARE THE RECIPIENTS OF THE BILL TAINTER SCHOLARSHIP PROGRAM. BEFORE I TURN THIS OVER TO EACH SUPERVISOR TO INTRODUCE THE RECIPIENT FROM THEIR DISTRICT, WE JUST WANT TO SHARE A LITTLE BIT ABOUT THIS SCHOLARSHIP PROGRAM. BILL TAINTER WAS A LONG-TIME ADVOCATE FOR PERSONS WITH DISABILITIES AND A NATIONALLY RECOGNIZED LEADER AND ROLE MODEL IN THE DISABILITY COMMUNITY. THE LOS ANGELES COUNTY COMMISSION ON DISABILITIES ESTABLISHED THE TAINTER MEMORIAL SCHOLARSHIP PROGRAM TO OFFER HIGH SCHOOL STUDENTS WITH DISABILITIES THE FINANCIAL OPPORTUNITY TO BECOME MORE INDEPENDENT AND SELF-SUFFICIENT THROUGH HIGHER EDUCATION. TODAY'S RECIPIENTS ARE NO DIFFERENT AND ARE EXCEPTIONAL ROLE MODELS. SO WE'RE GOING TO BEGIN WITH THE FIRST DISTRICT AND SUPERVISOR MOLINA? 

SUP. MOLINA: MR. CHAIRMAN AND MEMBERS, I'M PLEASED TODAY TO HONOR MICHELLE GARCIA, THE TAINTER SCHOLARSHIP RECIPIENT WITHIN OUR FIRST DISTRICT. MICHELLE IS A GRADUATING HIGH SCHOOL SENIOR AND PLANS TO ATTEND L.A. CITY COLLEGE. HER GOAL IS TO BE A SPECIAL EDUCATION TEACHER OR AN AMERICAN SIGN LANGUAGE INTERPRETER. MICHELLE, WE WANT TO APPLAUD YOU ON YOUR DESIRE TO PURSUE YOUR GOALS AND PRESENT YOU WITH A CERTIFICATE ACKNOWLEDGING YOUR GOOD WORK AND THE TERRIFIC GOALS THAT YOU HAVE BUT, MORE IMPORTANTLY, A CHECK FOR $2,000 THAT'S BEEN BROUGHT ABOUT. WE'RE VERY PROUD OF THE BILL TAINTER SCHOLARSHIP. IT IS HELPING A LOT OF STUDENTS AND I'M SURE IT'S GOING TO HELP YOU ACHIEVE YOUR GOALS. CONGRATULATIONS, MICHELLE. 

SUP. KNABE, CHAIR: I'M GOING TO ASK THE CHAIR TO JOIN IN THERE, SUPERVISOR MOLINA, FOR A PHOTO. 

SUP. MOLINA: SAY A FEW WORDS, IF YOU WOULD. YOU DON'T WANT TO? ALL RIGHT. WE'RE GOING TO PRESENT THE CHECK. 

SUP. KNABE, CHAIR: OKAY. SUPERVISOR BURKE? [ APPLAUSE ] 

SUP. BURKE: IT'S MY PLEASURE TO MAKE THIS PRESENTATION OF THE BILL TAINTER SCHOLARSHIP IN THE SECOND DISTRICT TO MARQUES TILLIE. GRADUATED FROM HAMILTON HIGH SCHOOL. HE'S GOING TO GO ON TO DOMINQUEZ HILLS TO STUDY GRAPHIC DESIGN. AND I WANT TO ENCOURAGE HIM TO KEEP UP HIS OUTSTANDING COMMUNITY SERVICE AND I KNOW HE'LL HAVE HIS HANDS FULL IN COLLEGE, BUT THERE'S ALWAYS TIME. AND HE'S ACCOMPANIED HERE BY HIS MOTHER AND FATHER, MR. AND MRS. TILLIE, AND ALSO BY CAROL LANE, WHO'S CHAIR. $2,000 SCHOLARSHIP. CONGRATULATIONS. [ APPLAUSE ] 

SUP. KNABE, CHAIR: VERY GOOD. CONGRATULATIONS. SUPERVISOR YAROSLAVSKY. 

SUP. YAROSLAVSKY: THANK YOU, MR. CHAIRMAN. WE ARE HONORED TO PRESENT THE SCHOLARSHIP FROM THE COUNTY COMMISSION ON DISABILITIES BILL TAINTER SCHOLARSHIP PROGRAM TO ARAM GORGANIA. ARAM IS A RESIDENT OF SANTA MONICA, CALIFORNIA, IN THE THIRD SUPERVISORIAL DISTRICT. HE HAS ATTENDED SANTA MONICA HIGH SCHOOL. HE'S GOING TO BE ATTENDING A FOUR-YEAR UNIVERSITY AT LA SIERRA UNIVERSITY IN RIVERSIDE. AND HE'S AN EXTREMELY MOTIVATED AND TALENTED YOUNG MAN WHO I THINK HAS A VERY EXCITING FUTURE AND WE'RE VERY HONORED TO BE ABLE TO PRESENT THIS SCHOLARSHIP TO YOU TO HELP YOU CONTRIBUTE TO THE ECONOMY OF RIVERSIDE COUNTY, OUR NEIGHBOR TO THE EAST, AND WE WISH YOU WELL, ARAM, IN YOUR COLLEGE CAREER AND IN THE YEARS BEYOND. CONGRATULATIONS. AND I WANT TO INTRODUCE HIS MOTHER, MRS. GORGANIA, IS HERE. SEZZA, SEZZA GORGANIA. THANK YOU FOR BEING HERE AND CONGRATULATIONS. OH, I'M SORRY, AND CAROL LANE, THE CHAIR. COME ON OVER HERE. [ APPLAUSE ] 

SUP. KNABE, CHAIR: CONGRATULATIONS. 

SUP. KNABE, CHAIR: THE FOURTH DISTRICT SCHOLARSHIP RECIPIENT, PAULINE VASQUEZ, IS OUR HONOREE, BUT SHE'S UNABLE TO BE HERE. SHE AND HER FAMILY ARE OUT OF TOWN BUT SHE'S GOING TO RECEIVE HER SCHOLARSHIP AND CERTIFICATE AT A LATER DATE. BUT I JUST WANTED TO SHARE A COUPLE THINGS ABOUT HER. PAULINE IS A OUTSTANDING STUDENT AT LOS ALTOS HIGH SCHOOL IN HACIENDA HEIGHTS. SHE IS ACTIVE IN CHEERLEADING, VOLLEYBALL, AND STUDENT GOVERNMENT. SHE HAS BEEN ADMITTED TO THE UNIVERSITY OF NEVADA AT LAS VEGAS, WHERE SHE PLANS TO MAJOR IN CHILD PSYCHOLOGY. IN HER SCHOLARSHIP APPLICATION, THIS IS WHAT SHE HAD TO SAY: "THE REALIZATION THAT I HAVE A LEARNING DISABILITY HAS GIVEN ME THE COURAGE TO WORK HARDER TOWARDS SUCCESS, SELF-SUFFICIENCY, AND INDEPENDENCE." SO, THE HARD WORK AND THE HURDLES THAT SHE'S ENCOUNTERED ALONG THE WAY HAVE MADE HER REALIZE HOW IMPORTANT IT IS TO NOT ONLY HELP HERSELF BUT TO HELP OTHERS. SO SHE'S AN EXCEPTIONAL YOUNG WOMAN AND WE WANTED TO CONGRATULATE PAULINE AND WE LOOK FORWARD TO VISITING WITH HER IN THE NEAR FUTURE. IT'S ALSO MY PLEASURE TODAY TO WELCOME THE FIFTH DISTRICT TAINTER SCHOLARSHIP RECIPIENT, KRISTIAN BASTISTE. SO, ON BEHALF OF SUPERVISOR ANTONOVICH, IT'S MY PLEASURE TO INTRODUCE KRISTIAN, AN OUTSTANDING STUDENT AT THE DIAMOND RANCH HIGH SCHOOL IN POMONA. HE WAS A MEMBER OF THE TRACK AND CROSS COUNTRY TEAM. HIS DREAM IS TO BECOME A COMPUTER AND SOFTWARE PROGRAMMER. IN THE NEXT FEW MONTHS, HE'S GOING TO TAKE SOME MAJOR STEPS TOWARDS FULFILLING THAT DREAM AS HE'S BEEN ACCEPTED TO THE UNIVERSITY OF NEW MEXICO. SO, ON BEHALF OF SUPERVISOR ANTONOVICH AND THE REST OF US, WE'D LIKE TO PRESENT YOU THIS CERTIFICATE BUT, MOST IMPORTANTLY, THE SCHOLARSHIP, AND SAY CONGRATULATIONS AND GOOD LUCK DOWN THERE AT THE UNIVERSITY OF NEW MEXICO. [ APPLAUSE ] 

SUP. KNABE, CHAIR: AND HE ALSO HAS HIS MOM AND DAD ALONG, TOO, SO WE APPRECIATE THAT AND GOOD LUCK DOWN THERE. CAROL LANE? 

CAROL LANE: I REALLY WASN'T PREPARED TO SAY ANYTHING THIS MORNING BUT I WOULD LIKE, AGAIN, TO CONGRATULATE ALL OF THE SCHOLARSHIP AWARDEES, AND JUST TO SAY THAT THE COMMISSION IS VERY PROUD OF THIS PARTICULAR OPPORTUNITY TO GIVE THESE DESERVING YOUNG PEOPLE A SCHOLARSHIP AND, HOPEFULLY, A LEG UP ON THEIR FUTURE, AND WE WANT TO FOLLOW THEM AS THEY GO FORWARD, AND CONGRATULATIONS AGAIN. [ APPLAUSE ] 

SUP. KNABE, CHAIR: THANK YOU, CAROL. ALL RIGHT. THANKS TO EVERYONE. I BELIEVE SUPERVISOR BURKE IS UP NEXT. DO YOU HAVE ANY PRESENTATIONS, ZEV, WHILE WE WAIT FOR SUPERVISOR BURKE? OKAY. 

SUP. YAROSLAVSKY: IF I COULD ASK DEIDRE KUPER TO JOIN ME FOR A MOMENT. MR. CHAIRMAN AND MEMBERS OF THE BOARD, IT'S AN HONOR THIS MORNING TO WELCOME AND HONOR DEIDRE KUPER, WHO IS A RESOURCE COORDINATOR FOR THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. DEIDRE HAS BEEN VERY INSTRUMENTAL IN THE ADOPT A CHILD ABUSE CASEWORKER PROGRAM, WHICH WAS ORIGINALLY SET UP ON A TWO-YEAR GRANT IN 1991 THROUGH THE STEWARD FOUNDATION AND THEN FUNDED FOR THREE YEARS BY THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. IN 1993, THE SAN FERNANDO VALLEY INTERFAITH COUNCIL TOOK THE LEAD IN THE PROGRAM UNTIL 2002, WHEN IT WENT BACK TO D.C.F.S. THIS UNIQUE PROGRAM MATCHES CHILDREN'S SOCIAL WORKERS WITH COMMUNITY LIAISONS SELECTED FROM CONGREGATIONS AND CIVIC ORGANIZATIONS TO PROVIDE GOODS AND SERVICES TO THE CHILDREN AND FAMILIES THAT WOULD NOT OTHERWISE BE PROVIDED FOR BY THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. DEEDEE KUPER WAS THE REGION 5, SPA 2 AREA RESOURCE COORDINATOR FOR THE NORTH HOLLYWOOD, SANTA CLARITA, AND PASADENA OFFICES FROM 2000 TO 2004. SHE WORKED CLOSELY WITH THE SAN FERNANDO VALLEY INTERFAITH COUNCIL, WITH THE A.C.A.C. PROGRAM UNTIL 2002, AND THEN SHE TOOK OVER SUPERVISING THE PROGRAM DIRECTLY. DEEDEE WAS ALWAYS A HANDS-ON PERSON AND WAS THE MAIN CONTACT TO THE COMMUNITY LIAISONS AND PERSONALLY RECRUITED LIAISONS TO START THE PROGRAM IN THE SANTA CLARITA VALLEY. AND I KNOW IF MR. ANTONOVICH WAS HERE, HE WOULD BE JOINING ME IN THIS PRESENTATION BUT HE'S ABSENT-- HE'S OUT OF TOWN TODAY, SO HE ASKED ME TO REPRESENT HIM ON HIS BEHALF AS WELL FOR THE WORK YOU'VE DONE IN HIS DISTRICT. THE REGION 5 SPA 2 A.C.A.C. PROGRAM INCLUDED 45 CONGREGATIONS, CIVIC ORGANIZATIONS, SCHOOLS CONNECTED WITH THE NORTH HOLLYWOOD OFFICE AND 12 CONGREGATIONS WITH THE PASADENA OFFICE. OVER 33 CHILDREN SERVED AS SOCIAL WORKERS ARE PRESENTLY ADOPTED. AS COMMUNITY LIAISONS WERE KEY TO THE SUCCESS OF THE PROGRAM, DEEDEE MADE SURE THAT EACH SOCIAL WORKER AT A COMMUNITY LIAISON WERE A GOOD MATCH. SHE HAD MONTHLY POT LUCK LUNCHES TO BRING BOTH THE SOCIAL WORKER AND LIAISONS TOGETHER, SHE HELD ANNUAL VOLUNTEER COMMUNITY LIAISON RECOGNITION EVENTS AND WAS ALWAYS AVAILABLE TO MEET AND TALK TO LIAISONS AND TOOK AN ACTIVE ROLE IN CONTINUING TO RECRUIT NEW ONES. BECAUSE OF HER COMPASSION AND COMMITMENT TO CHILDREN AND FAMILIES AND HER PERSONAL RELATIONSHIPS WITH THE COMMUNITY LIAISONS, SHE WENT ABOVE AND BEYOND THE LINE OF DUTY AND SHE WAS RESPECTED AND LOVED BY BOTH COMMUNITY LIAISONS AND SOCIAL WORKERS AS WELL. IT'S REALLY A PRIVILEGE FOR ME TO RECOGNIZE, AND I THINK WHEN WE DO RECOGNIZE PEOPLE WHO HAVE WORKED FOR US IN THIS WAY, WHAT BINDS THEM ALL TOGETHER IS THAT IT'S NOT JUST A JOB, IT'S A CALLING, AND THEY GO BEYOND THE CALL OF DUTY IN DEVELOPING THE RELATIONSHIPS WITH THE COMMUNITY AND PUT NOT ONLY THE COUNTY'S BEST FACE FORWARD, BUT ALSO, AND MORE IMPORTANTLY, PUT THE INTERESTS OF THE CHILDREN, WHO ARE OUR CLIENTS AT THE END OF THE DAY, FRONT AND CENTER. AND, DEIDRE, THANK YOU SO MUCH FOR YOUR SERVICE. WE WANTED TO RECOGNIZE YOU WITH THIS PROCLAMATION SIGNED BY ALL FIVE OF US, AND IT READS, "IN GRATEFUL APPRECIATION FOR YOUR CARING AND DEDICATED SERVICE AS RESOURCE COORDINATOR FOR THE ADOPT A CHILD ABUSE CASEWORKER PROGRAM" AND CONGRATULATIONS ON BEHALF OF ALL OF US. THANK YOU. [ APPLAUSE ] 

DEIDRE KUPER: THANK YOU, BOARD OF SUPERVISORS, AND ZEV, AND SUPERVISOR ANTONOVICH FOR THIS PRIVILEGE. IT'S REALLY AN HONOR TO BE HERE TO REPRESENT THE COMMUNITY, THE ADOPT A CASEWORKER PROGRAM AND ALL OF THE WONDERFUL WORK THAT'S BEING DONE FOR FOSTER YOUTH. THANK YOU. 

SUP. YAROSLAVSKY: HANG ON A SECOND, DEEDEE. I DIDN'T KNOW THAT BEHIND ME WAS THE MAN WHO RUNS THE DEPARTMENT, AND I'D LIKE TO ASK HIM TO SAY A WORD, DR. DAVID SANDERS. DAVID? 

DAVID SANDERS: I JUST WANT TO THANK THE BOARD OF SUPERVISORS FOR RECOGNIZING DEEDEE KUPER. SHE HAS DONE AN INCREDIBLE JOB IN NORTH HOLLYWOOD WITH FOCUS ON SAN FERNANDO, SAN GABRIEL VALLEYS AND THE RESPECT THAT SHE HAS WITHIN THE COMMUNITY AS WELL AS WITHIN THE DEPARTMENT IS CERTAINLY REFLECT BY THIS COMMENDATION, SO THANK YOU FOR THE GREAT WORK YOU'VE DONE. [ APPLAUSE ] 

SUP. KNABE, CHAIR: NOW I'M GOING TO ASK MR. JOHN MCKIBBEN COULD COME FORWARD, PLEASE, AND BRING HIS WIFE AND FAMILY AND TO JOIN US UP HERE. JOHN IS A FRIEND TO ALL OF US. HE IS GOING TO DO THAT WONDERFUL THING CALLED RETIREMENT. JOHN STARTED HIS CAREER IN 1970 WITH THE COUNTY. HE WORKED FOR THE PROBATION DEPARTMENT, LACERA, AND THEN FINALLY THE EXECUTIVE OFFICE OF THE BOARD OF SUPERVISORS. DURING HIS 20-YEAR TENURE WITH THE EXECUTIVE OFFICE, JOHN WAS RESPONSIBLE FOR LEGISLATION, LOBBYIST REPORTING, CONFLICT OF INTEREST, LACERA ELECTIONS AND NUMEROUS OTHER ISSUES. HE'S ALSO SERVED HIS COMMUNITY WELL BY BEING INVOLVED WITH THE PEACE CORPS FOR TWO YEARS. HE'S VERY ACTIVELY INVOLVED WITH HIS ALMA MATER, U.C. BERKELEY ALUMNI GROUP, WHERE HE GRADUATED WITH A POLITICAL SCIENCE MAJOR. JOHN IS MARRIED, HAS TWO DAUGHTERS. AND SO, ON BEHALF MYSELF AND MY COLLEAGUES, WE WANT TO SAY A HEARTFELT THANKS TO JOHN, TO HIS FAMILY FOR ALLOWING HIM TO DO HIS JOB, MOST IMPORTANTLY TO WISH HIM THE VERY, VERY BEST AND ENJOYMENT IN RETIREMENT. VIOLET, I'M GOING TO ASK YOU TO JOIN ME UP HERE. SO DO YOU WANT TO SAY A COUPLE WORDS BEFORE WE DO THE... 

CLERK VARONA-LUKENS: WELL, I, TOO, WANT TO THANK JOHN FOR HIS HARD WORK AND COMMITMENT AND LOYALTY TO THE EXECUTIVE OFFICE, AND I CAN TELL YOU, AND I'M SURE MOST OF YOU WHO HAVE WORKED WITH HIM KNOW THAT THERE IS NO ONE IN THE COUNTY OF LOS ANGELES WHO HAS THE PASSION FOR LEGISLATION LIKE JOHN. I KNOW THAT I CAN SAY THIS ON BEHALF OF THE CLERKS FROM THROUGHOUT THE STATE, THAT MANY OF THEM WOULD NOT BE ABLE TO DO IT WITHOUT THE ASSISTANCE AND HELP OF JOHN, AND I CERTAINLY APPRECIATE IT AND I WANT TO THANK HIM AND WISH HIM WELL ON THIS TRANSITION AS HE MOVES INTO ANOTHER PHASE OF HIS LIFE. [ APPLAUSE ] 

JOHN MCKIBBEN: WELL THANK YOU, SUPERVISOR KNABE. THANK YOU, SUPERVISORS, AND THANK YOU, VIOLET, FOR THOSE KIND WORDS. I'VE HAD FAR TOO GOOD A TIME HERE THE LAST ALMOST 21 YEARS IN THE EXECUTIVE OFFICE. THERE'S A FEW PEOPLE TO THANK. I WANT TO BE SURE AND THANK MY WIFE, SALLY, AND MY DAUGHTERS, SUSAN AND EMILY, FOR ALL THE LOVE AND SUPPORT THAT THEY'VE GIVEN ME OVER THE YEARS. WORKING IN THE EXECUTIVE OFFICE HAS REALLY BEEN, AS I SAID, A WONDERFUL TIME. I HAD A GREAT GROUP OF PEOPLE TO WORK WITH AND THERE ARE A FEW PEOPLE OUT THERE IN THE AUDIENCE I PARTICULARLY WANT TO THANK: THE STAFF OF MANAGEMENT SERVICE THAT HAVE WORKED WITH ME, SUPPORTED ME FOR QUITE A FEW YEARS. THANK YOU SO MUCH, GUYS. APPRECIATE IT. AND I WANT TO ALSO THANK A SERIES OF EXECUTIVE OFFICERS WHO MADE MY JOB SO MUCH EASIER AND SO MUCH FUN BY LETTING ME JUST GO AND DO WHAT I THOUGHT THAT NEEDED TO BE DONE, SO THANK YOU, VIOLET, FOR THAT. AND I ALSO WANT TO THANK SOMEBODY WHO IS NOT HERE TODAY BUT, IN CASE HE'S UP LATE TOMORROW NIGHT WATCHING THIS BROADCAST ON TELEVISION, I WANT TO THANK MY FRIEND AND MENTOR, LARRY MONTE, WHO BROUGHT ME DOWN HERE TO THE EXEC OFFICE. THANK YOU VERY MUCH. [ APPLAUSE ] 

SUP. KNABE, CHAIR: ALL RIGHT. WE'LL PROCEED WITH THE AGENDA. ALL RIGHT. WE'LL BEGIN WITH DISTRICT NUMBER ONE. SUPERVISOR MOLINA? 

SUP. MOLINA: THANK YOU, MR. CHAIRMAN. I DON'T HAVE ANY ITEMS THAT I'VE HELD BUT I HAVE TWO ADJOURNMENTS. FIRST OF ALL, I'D LIKE TO ASK THAT WE ADJOURN IN THE MEMORY OF MARINE CORPORAL ROBERTO ABAD OF BATTALION LANDING TEAM 11TH MARINE EXPEDITIONARY UNIT OF-- WHO WAS KILLED IN THE LINE OF DUTY WHILE SERVING OUR COUNTRY IN IRAQ. CORPORAL ABAD, BASED IN CAMP PENDLETON, WAS A RESIDENT OF BELL GARDENS. WE WANT TO EXTEND OUR DEEPEST CONDOLENCES TO HIS PARENTS, ROBERTO AND MARIA ELENA ABAD, HIS SIX SIBLINGS AND THE ENTIRE FAMILY. AND WE JUST LEARNED THAT... 

SUP. KNABE, CHAIR: SO ORDERED. 

SUP. MOLINA: ...THAT VERLENE HARRISON, COUNCILWOMAN, CITY OF INDUSTRY, DIED YESTERDAY AFTER A LONG ILLNESS. 

SUP. KNABE, CHAIR: OKAY. ALL MEMBERS ON THAT. SO ORDERED. SUPERVISOR BURKE? YOUR ADJOURNMENTS OR ANY ITEMS YOU HAVE. 

SUP. BURKE: I MOVE THAT, WHEN WE ADJOURN TODAY, WE ADJOURN IN THE MEMORY OF ILA MAE HUNTER, LONG-TIME RESIDENT OF SECOND DISTRICT, PASSED AWAY ON AUGUST 2ND AT THE AGE OF 87. SHE'S SURVIVED BY HER SON, REVEREND BILLY WEAVER AND STEPDAUGHTER, NORMA GENE BERNHARD. AND TOMMY LEE MEANS. TOMMY LEE MEANS WAS AN EMPLOYEE OF C.D.C. SINCE AUGUST 31ST, '95. HE BEGAN WORKING AS A MAINTENANCE WORKER AT UJIMA VILLAGE AND ONLY RECENTLY TRAVELED TO WORK AT THE C.D.C. PUBLIC HOUSING SITES IN THE NORTHERN PART OF THE COUNTY. AT THE AGE OF 40, HE WAS A VICTIM OF SENSELESS STREET VIOLENCE. HE'S SURVIVED BY HIS WIFE, LATANYA, AND SONS, TOMMY LEE MEANS JUNIOR, TRAVON, MARKEE MEANS AND TIMOTHY ANJUAN MEANS. THE HONORABLE VICTOR T. BARRERA, A FORMER JUDGE OF THE LOS ANGELES MUNICIPAL COURT AND LOS ANGELES COUNTY SUPERIOR COURT. DURING HIS 20 YEARS ON THE BENCH AND A FEW MORE AS PRIVATE MEDIATOR FOR ACTION DISPUTE RESOLUTION SERVICES, JUDGE BARRERA BECAME KNOWN STATEWIDE AS AN EXPERT IN SETTLEMENTS, MUTUAL AGREEMENTS AMONG ALL PARTIES TO RESOLVE LITIGATION WITHOUT A TRIAL. HE PASSED AWAY ON SATURDAY OF CANCER AT THE AGE OF 65. HE'S SURVIVED BY HIS WIFE, SHARON, SONS, MARK AND JOSEPH, AND DAUGHTERS BROOKE CORNWELL AND SHELLY OLYMPUS. AND THE LEGENDARY DEEJAY OF THE 1950S, HUNTER HANCOCK, WHO PASSED AWAY AUGUST 4, 2004, AT THE AGE OF 88. HE WAS KNOWN AS THE "OL' H.H." HE WAS HEARD OVER LOCAL AIRWAYS, KGFJ, KPOP, FROM 1943 TO '68, AND A BRIEF RUN ON KCBS TV CHANNEL 2 INTERVIEWING SUCH MUSICIANS AS DUKE ELLINGTON, FATS DOMINO, LITTLE RICHARD AND THE PLATTERS. IN 1956, THE LOS ANGELES SENTINEL RATED HIM THE MOST POPULAR DEEJAY IN LOS ANGELES AMONG AFRICAN-AMERICAN LISTENERS IN SOUTHERN CALIFORNIA. HOWEVER, TO THE SURPRISE OF BLACK AND WHITE AUDIENCES AT LIVE CONCERTS, HANCOCK WAS WHITE. HE IS SURVIVED BY HIS DAUGHTER, ROSEMARY DAVIS, AND TWO OTHER CHILDREN, VICTORIA HAWKS AND MYRON MILLS, SIX GRANDCHILDREN, FIVE GREAT- GRANDCHILDREN AND TWO GREAT, GREAT, GRANDCHILDREN. AND ROBERT "WILLIE" EAGAN, WHO PASSED AWAY AUGUST 5TH AT DANIEL FREEMAN HOSPITAL AT THE AGE OF 70 OF CANCER. HE WAS AN R AND B RECORDING ARTIST IN THE '50S. IN 1983, HE WAS AN UNEMPLOYED HOSPITAL WORKER LIVING IN SOUTH CENTRAL LOS ANGELES WHEN AN R AND B PROMOTER FOUND HIM MAKING A COMEBACK AND HE MADE A COMEBACK PERFORMING IN LONDON'S ELECTRIC BALLROOM. HE RECORDED AN ALBUM AND LATER PERFORMED IN LOS ANGELES. HE'S SURVIVED BY HIS SON, WILLIE EAGAN, JR. 

SUP. KNABE, CHAIR: SO ORDERED. 

SUP. BURKE: I HAVE A MOTION THAT I'M INTRODUCING TODAY. WE'VE HAD A LOT OF DISCUSSION ABOUT KING DREW AND, PARTICULARLY, DREW HOSPITAL, THE AFFILIATION AGREEMENT, AND THE SATCHER COMMITTEE. THE SATCHER GROUP MADE RECOMMENDATIONS AND I GET THE IMPRESSION THAT EVERYONE THINKS THAT NO ONE'S BEEN DOING ANYTHING SINCE THEN. HOWEVER, A STEERING COMMITTEE WAS FORMED, MADE UP OF DISTINGUISHED MEDICAL LEADERS, WHETHER THEY'RE FROM THE PRIVATE SECTOR, FROM THE ACADEMIC COMMUNITY, AND THAT GROUP HAS BEEN MEETING, THEY'VE BEEN LOOKING AT THE AFFILIATION AGREEMENT, TO BRING CHANGES THAT WOULD HAVE GREATER ACCOUNTABILITY. THEY HAD THEIR INPUT INTO IT. THEY WILL CONTINUE TO HAVE INPUT INTO IT. THEY HAVE PUT MONEY FORTH TO PROVIDE FOR AN AUDIT OF THE MEDICAL SCHOOL AND HOW THE FUNDS FLOW BETWEEN THE HOSPITAL AND THE MEDICAL SCHOOL. THEY HAVE BEEN ABLE TO IDENTIFY FOUNDATION FUNDS TO ASSIST POSSIBLY WITH ADMINISTRATION OF THE MEDICAL SCHOOL. THEY HAVE PAID FOR THE DIRECTORS AND THE-- OF THE MEDICAL SCHOOL TO GET TRAINING AT VANDERBILT UNIVERSITY. AND WHAT I AM ASKING IS THAT WE HAVE THEM APPEAR BEFORE US SO EVERYONE CAN FIND OUT WHAT THEY HAVE BEEN DOING AND WE CAN GET AN UPDATE IN TERMS OF THE ACTIVITIES AND WHAT THEY ARE ATTEMPTING TO DO FOR THAT MEDICAL SCHOOL. SO I'D LIKE TO ASK THAT THIS BE SET AS A SPECIAL ITEM, I WAS GOING TO SAY SEPTEMBER 8TH BUT WHEN WOULD BE THE BEST TIME TO SET IT? THE 14TH OF SEPTEMBER TO HEAR FROM THEM. AND I WANT EVERYONE TO HAVE A CHANCE TO HEAR FROM THESE DISTINGUISHED PEOPLE WHO HAVE BEEN PART OF THIS STEERING COMMITTEE AS A FOLLOW-UP TO THE SATCHER COMMITTEE REPORT. 

SUP. KNABE, CHAIR: OKAY. IT'S BEEN MOVED AND SECONDED. WE CAN DO THAT TODAY. SO MOVE URGENCY. NO NEED TO DO THAT? OKAY. IT'S BEEN MOVED AND SECONDED. ANY DISCUSSION? ANY OBJECTIONS? SO ORDERED. 

SUP. BURKE: YOU KNOW, I DID NOT GIVE THEN ANY NOTICE BUT IS THERE ANYONE HERE FROM PUBLIC HEALTH? I'D REALLY LIKE TO ASK A COUPLE OF QUESTIONS. CAN WE GET SOMEONE FROM PUBLIC HEALTH OUT HERE? I WANT TO GET BETTER INFORMATION ABOUT THE WEST NILE VIRUS. NOW, I SAW THE REPORT THAT CAME OUT THAT SAID, "DON'T CALL ABOUT DEAD BIRDS IN THESE PARTICULAR ZIP CODES" BECAUSE THEY HAVE ALREADY FOUND DEAD BIRDS THERE AND YOU KNOW THAT THE VIRUS IS ACTIVE THERE, BUT THERE ARE OTHERS THAT, APPARENTLY, YOU DO NOT KNOW ABOUT. MY REAL QUESTION IS, WHAT HAPPENS TO THE ORDINARY PERSON WHO IS BITTEN BY A MOSQUITO? IS THERE ANYTHING THEY SHOULD DO BESIDES GET HYSTERICAL? [ LAUGHTER ] 

SUP. BURKE: WHAT SHOULD THEY-- YOU KNOW, IF IT'S-- IF EVERYBODY IS FEELING LIKE I AM, IF A MOSQUITO COMES NEAR ME, I'M, YOU KNOW, I IMMEDIATELY START REACHING FOR SOMETHING. WHAT ARE YOU SAYING TO PEOPLE? I DON'T MEAN PEOPLE WHO HAVE ACTUALLY CAUGHT WEST NILE, I DON'T MEAN PEOPLE WHO HAVE BEEN BITTEN NEAR A DEAD BIRD. WHAT I WANT TO FIND OUT, WHAT ARE YOU SAYING TO US IF WE HAVE A MOSQUITO BITE? DO WE RUSH TO THE DOCTOR? IS THERE ANYTHING WE CAN TAKE? IS THERE ANYTHING WE SHOULD DO? 

JOHN SCHUNHOFF: SUPERVISOR, FOR THOSE WHO HAVE ALREADY BEEN BITTEN, WE'RE BASICALLY ASKING THEM TO MONITOR ANY SYMPTOMS AND, IF THERE'S ANY SEVERE SYMPTOMS, THEY SHOULD THEN SEE THEIR DOCTOR. MOST PEOPLE ARE ASYMPTOMATIC FOR THIS. MOST PEOPLE WHO ARE BITTEN WILL NOT EVEN NOTICE THAT THEY'RE SICK WITH WEST NILE, AND THEY MAY BE INFECTED BUT NOT SICK AT ALL. AND SO BASICALLY WE'RE TRYING TO EMPHASIZE NOT ONLY PREVENTION IN THE FIRST PLACE SO THAT PEOPLE USE DEET AND PEOPLE TAKE CARE OF MOSQUITO BREEDING POOLS OF WATER THAT MAY BE AROUND THEIR NEIGHBORHOOD, BUT ONCE THE-- IF THEY ARE BITTEN, THE MAIN ISSUE IS JUST WATCH FOR ANY UNUSUAL SYMPTOMS, AND WE LIST ALL THOSE SYMPTOMS ON OUR WEBSITE AND ALL OF OUR PUBLICATIONS AS TO WHAT THEY ARE. 

SUP. BURKE: WELL, LET ME ASK YOU THIS: IF YOU'RE BITTEN BY AN INFECTED MOSQUITO, IS THERE ANY DIFFERENCE IN THAT BITE THAN ANY OTHER BITE OF A MOSQUITO? 

JOHN SCHUNHOFF: NO 

SUP. BURKE: LOOKS THE SAME? 

JOHN SCHUNHOFF: MM HM. 

SUP. BURKE: SO WHAT YOU NEED TO DO IS WATCH OUT TO SEE IF YOU GET A FEVER, IS THAT IT? 

JOHN SCHUNHOFF: THAT'S RIGHT. 

SUP. BURKE: THE OTHER THING, THE REASON WHY I WAS A LITTLE CONCERNED IS SOME OF THE PEOPLE SAY THEY WERE BITTEN A MONTH AND A HALF AGO. SO HOW SOON DO THESE SYMPTOMS COME UP? 

JOHN SCHUNHOFF: THERE IS AN INCUBATION PERIOD AND I BELIEVE IT'S ABOUT TWO WEEKS AT MAXIMUM BETWEEN THE TIME OF A BITE UNTIL SOMEONE WOULD GET SICK. 

SUP. BURKE: ALL RIGHT. SO THE TIME YOU REALLY NEED TO WATCH OUT IS ABOUT TWO WEEKS AFTER YOU'VE HAD A BITE? 

JOHN SCHUNHOFF: THAT'S RIGHT. 

SUP. BURKE: OKAY. AND IF THERE IS-- I UNDERSTAND THAT THERE IS SOME KIND OF A VACCINE BUT IT'S NOT BEING PRODUCED IN ANY QUANTITY TO BE AVAILABLE FOR PEOPLE? 

JOHN SCHUNHOFF: I DON'T KNOW OF ANY HUMAN VACCINE THAT'S BEEN APPROVED AT ALL. THERE IS AN EQUINE OR HORSE VACCINE THAT IS AVAILABLE FOR HORSES AND WE'VE RECOMMENDED STRONGLY THAT ALL HORSE OWNERS VACCINATE THEIR HORSES BECAUSE THEY'RE VERY SUSCEPTIBLE TO THE VIRUS. 

SUP. BURKE: I SEE. ARE THERE ANY OTHER ANIMALS THAT ARE SUSCEPTIBLE? 

JOHN SCHUNHOFF: WELL, PRIMARILY, THE FAMILIES OF BIRDS THAT ARE AFFECTED BUT... 

SUP. BURKE: BUT NOT DOGS OR CATS? 

JOHN SCHUNHOFF: DOGS AND CATS ARE NOT AFFECTED. 

SUP. BURKE: I SEE. ALL RIGHT. THANK YOU VERY MUCH. 

SUP. KNABE, CHAIR: THANK YOU. SUPERVISOR YAROSLAVSKY? 

SUP. YAROSLAVSKY: I HAVE A QUESTION, JOHN. HANG ON. WE'VE BEEN GIVING OUT TELEPHONE NUMBERS FOR PEOPLE TO CALL AND-- ABOUT WEST NILE-RELATED ISSUES: STAGNANT WATER, MOSQUITO BITES, THOSE KINDS OF THINGS. AND THERE HAVE BEEN TWO REFERENCES IN NEWSPAPERS IN THE LAST TWO DAYS TO THE FACT THAT PEOPLE HAVE GOTTEN TELEPHONE NUMBERS FROM ME AND CALLED THE NUMBERS AND NOBODY ANSWERS. DO YOU KNOW WHAT THE CORRECT NUMBER IS FOR PEOPLE TO CALL IF THEY HAVE AN ISSUE? OR CAN YOU GET IT SO THAT WE CAN... 

JOHN SCHUNHOFF: WE'LL GET-- WE'LL MAKE SURE YOU ALL HAVE THE CORRECT NUMBERS. 

SUP. YAROSLAVSKY: WELL, CAN WE GET IT TODAY, LIKE, IN THE NEXT FEW MINUTES, SO THAT WE CAN... 

JOHN SCHUNHOFF: YES. WE'LL HAVE IT BROUGHT RIGHT OVER TO THE BOARD. 

SUP. YAROSLAVSKY: I THINK IT'S CRITICALLY IMPORTANT THAT, IF WE'RE ASKING PEOPLE TO CALL THE COUNTY OFFICE TO GET INFORMATION OR TO REPORT SOMETHING, THAT SOMEBODY ANSWER THE PHONE. 

JOHN SCHUNHOFF: I AGREE. 

SUP. YAROSLAVSKY: I CAN'T THINK OF ANYTHING MORE INEXPLICABLE TO MY CONSTITUENTS THAN FOR THEM TO SAY, "WE CALLED AND IT RANG FOR FIVE MINUTES AND NOBODY ANSWERED." IT'S EITHER THE WRONG NUMBER OR SOMEBODY'S TAKING A LONG COFFEE BREAK. IT'S PROBABLY THE FORMER. 

SUP. BURKE: I JUST HAVE ONE OTHER QUESTION. I FORGOT TO ASK THIS. I KNOW THE CITY'S APPROACH HAS BEEN TO SAY IT'S A VIOLATION TO HAVE STANDING WATER. WOULD IT BE APPROPRIATE FOR US TO HAVE SOME KIND OF ORDINANCE IN THE UNINCORPORATED AREA THAT GIVES THE AUTHORITY TO THE HEALTH DEPARTMENT TO ENTER PRIVATE PROPERTY ANY TIME THEY SEE STANDING WATER TO TEST IT? DO YOU PRESENTLY HAVE THAT AUTHORITY? 

JOHN SCHUNHOFF: WE HAVE THE AUTHORITY TO CITE PEOPLE FOR STANDING WATER. WE GENERALLY DO NOT HAVE THE AUTHORITY TO GO ON TO PRIVATE PROPERTY. 

SUP. BURKE: YOU KNOW, I THINK THAT I'M GOING TO SAY THAT, FOR NEXT WEEK, I'LL INTRODUCE A MOTION TO GIVE THE AUTHORITY, IF IT'S POSSIBLE, I'LL ASK THE COUNTY COUNSEL TO FIND OUT IF THERE'S ANY STATE LAW THAT VIOLATES THIS, GIVE THE AUTHORITY TO ANY REPRESENTATIVE OF THE HEALTH DEPARTMENT OR ANY REPRESENTATIVE OF THE COUNTY OF LOS ANGELES, OFFICIAL REPRESENTATIVE, TO GO ON PRIVATE PROPERTY AT ANY TIME THERE APPEARS TO BE STANDING WATER AND TO DETERMINE IF THERE'S AN INFECTATION[SIC]. AND I'LL INTRODUCE THAT FOR NEXT WEEK. 

JOHN SCHUNHOFF: OKAY. 

SUP. KNABE, CHAIR: OKAY? SUPERVISOR YAROSLAVSKY, ANY ADJOURNMENTS? 

SUP. YAROSLAVSKY: MR. CHAIRMAN, I ASK THAT WE ADJOURN TODAY AT THE CONCLUSION OF THE MEETING IN THE MEMORY OF MICHAEL EAGAN, KNOWN AS A MASTER LUTE PLAYER. HE WAS ARTISTIC MUSIC DIRECTOR FOR MUSICA ANGELICA, WHO RECENTLY PASSED AWAY UNEXPECTEDLY. HE TRAVELED THROUGHOUT THE WORLD, RECORDED EXTENSIVELY WITH AMERICAN BACH SOLOIST PHILHARMONIA BAROQUE ORCHESTRA, BOSTON BAROQUE, AND MUSICA PACIFICA, AMONG OTHERS. HE IS SURVIVED BY HIS MOTHER, ELEANOR, AND OTHER FAMILY MEMBERS. ALSO ASK THAT WE ADJOURN IN THE NAME OF JAMIE FOSTER, THE LOS ANGELES CITY FIREFIGHTER-- SORRY, IT'S JAMIE FOSTER, A LOS ANGELES CITY FIREFIGHTER ASSIGNED TO STATION 73 IN ROSITA, WHO TRAGICALLY LOST HER LIFE, VERY TRAGICALLY, AT THE AGE OF 25 IN A VEHICLE ACCIDENT AFTER HELPING TO BATTLE A HOUSE FIRE THIS PAST WEEKEND. IN FACT, I WAS NOT FAR FROM THERE AT A CELEBRATION OF THE HIGHWAY PATROL'S 75TH ANNIVERSARY IN WOODLAND HILLS WHEN THE L.A. CITY FIRE CHIEF WAS CALLED TO RESPOND TO THIS GREAT TRAGEDY IN ROSITA. SHE WAS THE FIRST FEMALE CITY FIREFIGHTER TO FALL IN THE LINE OF DUTY AND HAD GRADUATED ONLY THREE MONTHS AGO FROM THE FIREFIGHTING ACADEMY. HER UNTIMELY DEATH IS A TREMENDOUS LOSS TO OUR ENTIRE COMMUNITY AS WELL AS TO THE DEPARTMENT, L.A. CITY FIRE DEPARTMENT, HER FAMILY MEMBERS, AND MANY FRIENDS. SHE IS SURVIVED BY HER MOTHER, GLORIA FOSTER, AND ASK THAT ALL MEMBERS JOIN IN THAT MOTION. 

SUP. KNABE, CHAIR: ALL MEMBERS. 

SUP. YAROSLAVSKY: THAT'S ALL I HAVE IN THE WAY OF ADJOURNING MOTIONS. MR. CHAIRMAN, I HAD HELD 13 FOR THE PURPOSES OF A SUGGESTION THAT WAS MADE TO ME ON THIS. THIS IS AN ACTION WHERE THE COUNTY IS ACTUALLY CASTING ITS VOTE ON AN ASSESSMENT DISTRICT. IS THAT CORRECT? 

C.A.O. JANSSEN: THAT'S CORRECT. 

SUP. YAROSLAVSKY: AND MY STAFF POINTS OUT TO ME THAT THE COST OF PROCESSING THE PAPER THROUGH YOUR OFFICE TO GET IT ONTO THE BOARD AGENDA PROBABLY EXCEEDS THE REVENUES THAT ARE GOING TO BE GENERATED FOR THIS-- BY OUR PORTION OF THIS ASSESSMENT. SO THE SUGGESTION WAS MADE THAT PERHAPS, IN THE FUTURE, WE COULD-- IF THE BOARD COULD GRANT YOU THE AUTHORITY TO CAST A VOTE UP TO $5,000 IN ASSESSMENT FEES SO THAT WE CAN SAVE THE HUNDREDS IF NOT MORE DOLLARS THAT IT TAKES TO PROCESS A BOARD LETTER AND ALL THAT SORT OF THING, AND THAT WAS GOING TO BE MY SUGGESTION AND LET DAVID... 

C.A.O. JANSSEN: THAT'S A GREAT IDEA. 

SUP. YAROSLAVSKY: ...AND THE BOARD EXECUTIVE OFFICE WORK THAT OUT. 

SUP. KNABE, CHAIR: WE RAISED THIS BEFORE. I THINK IT'D BE A VERY GOOD IDEA, SO WE'LL GO AHEAD AND PASS THIS... 

SUP. YAROSLAVSKY: YEAH, I MOVE APPROVAL... 

SUP. KNABE, CHAIR: YOU'LL BRING IN A MOTION, IS THAT CORRECT? 

SUP. YAROSLAVSKY: ...WHY DON'T YOU JUST BRING US A REPORT IN A WEEK OR TWO AND... 

C.A.O. JANSSEN: I'LL COME BACK WITH A LETTER AND DO THAT. 

SUP. KNABE, CHAIR: OKAY. SO, ON ITEM 13, THEN, MOVED BY SUPERVISOR YAROSLAVSKY, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. AN ADJOURNMENT IN MEMORY OF CAROLYN HUTCHINSON. CAROLYN WAS A 24-YEAR EMPLOYEE OF THE COMMUNITY DEVELOPMENT COMMISSION. DURING THAT TIME, SHE WORKED AS A PROPERTY SUPERVISOR IN VARIOUS PUBLIC HOUSING LOCATIONS THROUGHOUT THE COUNTY, INCLUDING HARBOR HILLS. FOR THE LAST 11 YEARS, SHE WAS THE PROPERTY SUPERVISOR AT CARMELITOS IN LONG BEACH AND SHE IS SURVIVED BY HER SON, HERONE, DAUGHTER-IN-LAW, AND GRANDDAUGHTER. AND SO I'D LIKE TO MOVE THAT ADJOURNMENT. SO ORDERED. ON BEHALF OF SUPERVISOR ANTONOVICH, HIS ADJOURNMENTS ALSO ARE JAMIE FOSTER AS WELL, TOO, THAT SUPERVISOR YAROSLAVSKY JUST MENTIONED, AND IT'LL BE ALL MEMBERS. ALSO IN MEMORY OF HUNTER HANCOCK, THAT WILL BE ALL MEMBERS AS WELL, TOO. AND ALSO THAT WE ADJOURN IN THE MEMORY OF TODAY OF DULCY BRADFORD RIMAC, A RESIDENT OF VALENCIA, RETIRED ELEMENTARY SCHOOL TEACHER. SHE WORKED FOR A DECADE AS A SECOND GRADE TEACHER AT HERRICK AVENUE SCHOOL IN SYLMAR. SHE WAS VERY INVOLVED WITH THE AMERICAN ASSOCIATION OF UNIVERSITY WOMEN, DAUGHTERS OF THE KING. AND SHE WAS AN USHER AT SAINT STEVENS EPISCOPAL CHURCH. AND TO HER FAMILY, WE ADJOURN IN MEMORY. I HELD A COUPLE OF ITEMS. LET'S SEE. OKAY. ITEM NUMBER 8 WAS HELD FOR THE PUBLIC. IF YOU'LL GIVE ME-- WE'LL MOVE ON THAT. ANDREW FRIED AND DOUG BARNETT, IF YOU'LL COME FORWARD, PLEASE. SIR, IF YOU'D IDENTIFY YOURSELF FOR THE RECORD AND PROCEED, PLEASE. 

DOUG BARNETT: DOUG BARNETT. IT'S A QUAKER HAT. ACTON. YOU HAVE AN ITEM THAT CONCERNS THE AGUA DULCE AIR PARK. WITHIN MY LIFETIME, MOST OF THE AGUA DULCE IN THE ACTON AREA WERE MINING CLAIMS, VERY LARGE PARCELS WITH ONLY VERY SPARSE POPULATION. A HUNDRED YEARS AGO, ACTON MIGHT HAVE BEEN THE SEAT OF THE STATE OF CALIFORNIA WHEN MINING WAS VERY LARGE THERE. THE THING THAT BOTHERS ME IS THAT AIR PARKS, SIERRA HIGHWAY, ALL OF THESE ARTIFACTS OF THE PAST ARE ALL SORT OF ENDANGERED BY THE CURRENT TREND, WHICH IS SINGLE-FAMILY DWELLINGS ON VERY SMALL PARCELS. IN 1989, THE PRESIDENT OF NORTHROP, AT THE INTRODUCTION OF THE B-2 BOMBER, FLEW IN IN A CESSNA AIRCRAFT FROM HIS FACTORY IN HAWTHORNE. THE PRIVATE AIRPLANE BUSINESS, FOR THE LAST HUNDRED YEARS, HAS GENERATED TREMENDOUS CHANGE. MOST OF THE INVENTION HAD A LOT MORE TO DO WITH FAMILIES AND INVENTORS. ONE OF THE LARGEST-- ONE OF THE PROMINENT HELICOPTER AIR FRAME MANUFACTURERS IN THE UNITED STATES IS A SINGLE-FAMILY IN TORRANCE. THEY PRODUCE THEIR OWN HELICOPTER. THEY HAVE FOR MANY YEARS. I'D REALLY LIKE TO SEE THIS BOARD OF SUPERVISORS LOOK VERY CAREFULLY AT RESOURCES LIKE THE AIR PARK AND HOLD THEM IN A LONGER VIEW THAN WHETHER OR NOT THE FILMING INDUSTRY IS PUSHING AGAINST THE CURRENT CROP OF NEW HOMEOWNERS OUT THERE. ONE OTHER ITEM IS THAT-- I'VE GOT ONE MORE MINUTE. THERE'S A RATHER ARTIFICIAL ARTIFACT CALLED THE 25-MILE LIMIT FOR PER DIEMS FOR THE MOVIE INDUSTRY. THIS-- RIGHT OR WRONG FOR THE-- FOR THOSE WHO MAKE THEIR LIVING IN THE MOVIES, IT FORCES FILM PRODUCTION WITHIN A VERY TIGHT RADIUS, INCLUDES VASQUEZ ROCKS, THE SAND CANYON AREA, AND ALL THREE OF THE OUTLYING DISNEY AND FOX STUDIO DISTANT FILMING AREAS. I'D LIKE TO SEE THE BOARD LOOK AT THAT AND, WITH THESE MODERN TIMES AND HIGH-SPEED S.U.V. TRANSPORTATION OUT THE 14 HIGHWAY AND DOWN IN ORANGE COUNTY, I THINK WE COULD EXTEND FILMING IN THE SOUTHERN CALIFORNIA AREA BY WORKING WITH THAT LIMIT, AND IT MIGHT HELP A LOT WITH WHETHER AGUA DULCE REMAINS THE CHOICE ON FILMING. 

SUP. KNABE, CHAIR: THANK YOU. YES, SIR. 

ANDREW FRIED: GOOD MORNING, MAYOR KNABE AND THANK YOU, BOARD MEMBERS, VERY MUCH. MY NAME IS ANDREW G. FRIED, I'M PRESIDENT OF THE AGUA DULCE TOWN COUNCIL. THE AGUA DULCE COUNCIL IS INTERESTED IN WORKING WITH WORKING WITH SUPERVISOR ANTONOVICH. THE AGUA DULCE CIVIC ASSOCIATION, THE CONCERNED CITIZENS OF AGUA DULCE, INC. AND THE AIR PARK MANAGEMENT, IN WORKING OUT A SOLUTION TO THE MYRIAD OF ISSUES INVOLVED IN THIS SITUATION. WE ARE, HOWEVER, VERY CONCERNED ABOUT THE MANY PROBLEMS THAT THE AIR PARK DOES CREATE FOR THE COMMUNITY. I WOULD LIKE TO QUOTE FROM SUPERVISOR ANTONOVICH'S MOTION. "INVESTIGATIONS BY COUNTY CODE ENFORCEMENT STAFF HAVE IDENTIFIED A SERIES OF VIOLATIONS OF COUNTY PERMIT CONDITIONS AT THE AGUA DULCE AIR PARK. AS A RESULT, THE COUNTY HAS ISSUED SEVERAL NOTICES OF VIOLATION TO THE OPERATOR OF THE AGUA DULCE AIR PARK. GIVEN THE CHANGES OCCURRING AT THE AGUA DULCE AIR PARK, THE LACK OF ADEQUATE CONTROLS IN THE UNDERLYING PERMIT, THE PENDING NOTICES OF VIOLATION, AND THE STEADY CHORUS OF CONCERNS EXPRESSED BY RESIDENTS OF AGUA DULCE, IT IS CLEARLY TIME FOR COUNTY DECISION MAKERS TO CONDUCT A PUBLIC HEARING TO REVIEW THESE MATTERS AND DETERMINE IF ADDITIONAL CONDITIONS ARE WARRANTED." I THEREFORE RESPECTFULLY REQUEST, ON BEHALF OF THE AGUA DULCE TOWN COUNCIL, THAT THE SUPERVISORS SUPPORT SUPERVISOR ANTONOVICH'S MOTION AND DO THE FOLLOWING: DIRECT THE DIRECTOR OF REGIONAL PLANNING TO TAKE THE STEPS NECESSARY TO CONDUCT A MODIFICATION/REVOCATION HEARING FOR THE AGUA DULCE AIR PARK AND DIRECT THAT THE REGIONAL PLANNING COMMISSION HOLD A NOTICED PUBLIC HEARING IN OR NEAR THE AGUA DULCE COMMUNITY AT THE EARLIEST DATE POSSIBLE. THE HEARING SHALL BE CONDUCTED AT A LOCATION AND TIME CONVENIENT TO THE AGUA DULCE RESIDENTS AND REGIONAL PLANNING STAFF SHALL CONSULT ON THESE DETAILS WITH REPRESENTATIVES OF THE AGUA DULCE TOWN COUNCIL AND THE FIFTH DISTRICT. SUPERVISORS, AFTER MANY YEARS OF CONTROVERSY, AND THIS AIRPORT HAS BEEN OPEN SINCE ROUGHLY 1959, THE COMMUNITY OF AGUA DULCE DESERVES AN OPPORTUNITY TO PARTICIPATE IN A PUBLIC HEARING REGARDING THE ISSUES THAT REALLY ARE OF ENORMOUS IMPORTANCE TO THE ENTIRE COMMUNITY. THANK YOU VERY MUCH FOR YOUR TIME. 

SUP. KNABE, CHAIR: THANK YOU. THE ITEM IS BEFORE US. MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. ITEM 19 IS A QUESTION I JUST HAVE FOR THE C.A.O. WE HAD TALKED ABOUT IN REGARDS TO WHETHER THIS IS DUPLICATING THE WORK OF OUR INDEPENDENT COUNCIL AND IF WE HAD ANY RESPONSE TO THAT. I MEAN, I'M NOT GOING TO HOLD UP THE ITEM, WE'LL MOVE FORWARD ON IT, BUT THE FACT IS THAT WE HAVE A COMPLETE REPORT. THIS IS SOMETHING WE'VE ASKED MR. BOBB TO DO BUT, AT THIS LATE DATE, I MEAN, ARE WE... 

RAY FORTNER, COUNSEL: MR. CHAIRMAN, MEMBERS OF THE BOARD, BASED ON THE WORK THAT MERRICK BOBB WAS ASKED TO DO UNDER THIS CONTRACT, WHILE IT GOES OVER SOME OF THE SAME GROUND, IT IS FROM HIS DIFFERENT PERSPECTIVE AND SERVING AS YOUR SPECIAL COUNCIL, SO IT IS NOT, IN THAT SENSE, DUPLICATIVE. 

SUP. KNABE, CHAIR: WELL, I MEAN, SORT OF AFTER THE FACT, THOUGH. I MEAN, IN THE SENSE THAT WE GOT ONE REPORT. IS THAT BEING THE BASIS OF THE REVIEW OR I THOUGHT THE INTENT WAS TO GET THE TWO DIFFERENT VIEWPOINTS SORT OF AT THE SAME TIME? 

RAY FORTNER, COUNSEL: WELL, I DON'T KNOW THAT WE KNEW THE TIMING OF THE O.I.R. REPORT OR ANY OTHER REPORT WHEN THIS WAS INSTRUCTED. 

SUP. KNABE, CHAIR: WELL, I UNDERSTAND... 

RAY FORTNER, COUNSEL: THIS REPORT IS OVERDUE FROM THE ORIGINAL BOARD ORDER. THAT IS CORRECT. 

SUP. KNABE, CHAIR: AND THIS IS UNUSUAL, TOO. IT'S OUTSIDE THE BOUNDS OF THE CONTRACT. NORMALLY, THERE'S NOT A COMPENSATION ISSUE ON TOP OF THE CONTRACT. IS THAT CORRECT? 

RAY FORTNER, COUNSEL: THAT'S WHY WE HAD TO BRING THE AMENDMENT FORTH TO YOU. THAT'S RIGHT. 

SUP. KNABE, CHAIR: OKAY. MOVED BY SUPERVISOR BURKE, SECONDED BY SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. ITEM 37, I JUST HAD AN AMENDMENT TO. MY STAFF WILL PASS IT OUT. THE AMENDMENT IS TO REQUEST THE INTERIM DIRECTOR OF PARKS AND RECREATION IN THE AFFECTED FOUNDATIONS TO EXPLORE THE FEASIBILITY OF EXTENDING THE FEE WAIVER TO THE COUNTIES FOUR ARBORETA AND BOTANIC GARDENS AND REPORT BACK TO THE BOARD IN A COUPLE OF WEEKS. THIS IS A PRETTY NICE DEAL AND I JUST THOUGHT, YOU KNOW, WITH OUR GARDENS AND EVERYTHING ELSE, THAT IT MIGHT BE A GOOD OPPORTUNITY FOR SOME OF THESE FOLKS TO VISIT THAT AS WELL, TOO, SO... OKAY. SO I'LL MOVE IT AS AMENDED. SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTIONS, SO ORDERED. WE HAVE THREE ITEMS HELD BY THE PUBLIC AND I BELIEVE THIS IS BY THE SAME PERSON, SO I'M GOING TO ASK GENEVIEVE TO COME FORWARD AND ADDRESS 22, 24, AND 29. 

GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS. JE SUIS GENEVIEVE CLAVREUL. I WANT TO SPEAK TO ALL THOSE ITEMS TOGETHER BECAUSE, FOR ME, THEY ARE JOINT. FIRST, I WANT TO THANK SUPERVISOR BURKE TO BRING THAT MOTION TO HAVE A COMPLETE REPORT FROM THE STEERING COMMITTEE. I THINK THAT'S OVERDUE AND THAT WOULD BE GREAT TO SEE IT. I THINK, AT THIS POINT, WHEN THERE'S ANY CONTRACT COMING UP TO BE RENEWED AT M.L.K., I THINK, AT THIS STAGE OF THE GAME, WE SHOULD GO TO MONTH-TO-MONTH RENEWAL AND NOT RENEW FOR A LONG PERIOD OF TIME. ON THE ONE ON ITEM NUMBER 29, IF THIS IS CORRECT, JOINT ACCREDITATION HAD A LOT OF COMPLAINTS ABOUT THE CAFETERIA, THE TEMPERATURE OF THE FOOD AND SO ON. THAT COMES DIRECTLY UNDER THE CONTRACTOR, SO I WOULD BE CONCERNED ABOUT THAT CONTRACT BEING RENEWED. I THINK WHEN WE TALK ABOUT... 

SUP. KNABE, CHAIR: THAT'S 29 IS ON A MONTH-TO-MONTH BASIS. 

GENEVIEVE CLAVREUL: WELL, THIS ONE IS ON A MONTH-TO-MONTH BUT EVEN, I THINK, BEFORE WE CONSIDER ANY FURTHER WORKING WITH THEM, THEY SHOULD CORRECT THE DEFECT AND, ON THE CONTRACT, IT DOES NOT SHOW THAT ATTEMPT AT, YOU KNOW, ARE INCLUDED IN THE CORRECTION. ON THE BIOTERRORISM. I THINK THAT'S A TREMENDOUS ISSUE FOR ALL OF US. I THINK ALL OF YOU ARE AWARE THIS WEEKEND, M.L.K. EMERGENCY ROOM WAS CLOSED FOR 60 HOURS... 

SUP. BURKE: THAT IS NOT CORRECT. THE EMERGENCY ROOM WAS NOT CLOSED. AMBULANCES WERE DIVERTED... 

GENEVIEVE CLAVREUL: IT'S THE SAME THING. I MEAN... 

SUP. BURKE: NO, IT IS NOT. 10% OF THE EMERGENCY-- PEOPLE WHO COME INTO THE EMERGENCY ROOM, COME BY AMBULANCE. 90% COME IN THROUGH THE DOOR. 

GENEVIEVE CLAVREUL: YOU WERE ON DIVERSION. 

SUP. BURKE: I JUST WANT YOU TO BE SURE THAT YOU HAVE IT CORRECT. 

GENEVIEVE CLAVREUL: YEAH. BUT, YOU KNOW, IT'S STILL THE SAME. YOU ARE HAVING, YOU KNOW, A HOSPITAL WHO IS NOT FUNCTIONING AT FULL CAPACITY. IS A HOSPITAL WHICH IS VERY CLOSE TO LAX. IF WE HAD BIOTERRORISM, THEY ALREADY DEPEND ON THAT HOSPITAL TO PROVIDE CARE. I THINK THAT WE HAVE THREE TEAMS OF PEOPLE AT THE HOSPITAL RIGHT NOW AND I WANT TO CORRECT SOMETHING THAT WAS SAID LAST WEEK. MR. LEAF IS NOT ALONE AT M.L.K. HE HAD THREE TEAMS TO WORK WITH, ONE OF THEM IS THE CAMDEN GROUP AND I THINK, FOR NURSES NOT SHOWING UP TO WORK, WHEN YOU HAVE THOSE TEAMS, REALLY POINT OUT THAT SOMETHING, IS THE MORALE OF THE NURSES AND THE PEOPLE WORKING AT M.L.K. ARE IN DISTRESS. AND I THINK IT'S TIME WE DO SOMETHING. AND IN AN ARTICLE THIS MORNING ABOUT M.L.K., THEY SAID SANCTION WILL BE TAKEN AGAINST PEOPLE CALL OUT SICK. YES, SANCTION NEED TO BE TAKEN CARE OF BUT THEY ARE NOT ON THE NURSES. THE PROBLEM AT M.L.K. IS THE LACK OF LEADERSHIP, A LACK OF MANAGEMENT. SANCTIONS SHOULD BE TAKEN, YES. GARTHWAITE SHOULD BE FIRED. SO FRED LEAF. AND THE CAMDEN GROUP SHOULD BE TAKEN OUT OF M.L.K. AND THEY SHOULD REIMBURSE US FOR ALL THE MONEY WE HAVE PAID THEM, AND I THINK M.L.K. IS THE CANARY WE USED TO TAKE TO THE MINE FOR THE AIR CHECK. AND I THINK WE NEED TO LOOK AT WHAT'S GOING ON. 

SUP. KNABE, CHAIR: THANK YOU. WITH THAT, CAN I TAKE ALL THREE ITEMS TOGETHER? IS THAT OKAY? ITEM 22, 24, AND 29, MOVED BY SUPERVISOR BURKE, THE CHAIR WILL SECOND. WITHOUT OBJECTION, SO ORDERED. I'D JUST ADD TO THAT COMMENT, GENEVIEVE. I HAD THE OPPORTUNITY, ON FRIDAY, TO VISIT A HOSPITAL AND TO BE PART-- TO LOOK AT THEIR BASE STATION OPERATION, AND I WOULD JUST TELL YOU, THERE ARE A LOT MORE HOSPITALS THAN M.L.K. ON DIVERSION AS IT RELATES TO THE E.R. AND SO, I MEAN, IT WAS NOT A ONE-HOSPITAL ISSUE. I MEAN, FROM VARIOUS SPECIALTY KINDS OF SITUATIONS TO JUST A GENERAL, YOU KNOW, CAPACITY ISSUES AND, YOU KNOW, BECAUSE YOU COULD SEE BY COMPUTER EVERY HOSPITAL LISTED, YOU CAN JUST ROLL IT, AND THOSE WHO WERE ON DIVERSION AND THOSE THAT WEREN'T. AND SO THIS IS NOT A SINGLE-HOSPITAL ISSUE AS IT RELATES TO DIVERSION AND CAPACITY FOR E.R.S. WE HAVE TWO PUBLIC HEARINGS. ITEM 76 IS A HEARING ON THE REVISION OF THE BILLABLE RATES. 

CLERK VARONA-LUKENS: MR. CHAIRMAN, I MIGHT ASK ANYONE WHO IS PLANNING TO TESTIFY ON ANY OF THE PUBLIC HEARING ITEMS... 

SUP. KNABE, CHAIR: ITEM 76 OR 77, ANYONE TESTIFYING, IF YOU'D PLEASE RISE. SEEING NONE. OKAY. ITEM 76, WE'LL OPEN THE PUBLIC HEARING. 

CLERK VARONA-LUKENS: AND I'LL READ THAT INTO THE RECORD. "HEARING ON REVISION OF BILLABLE RATES FOR MINORS DETAINED IN JUVENILE HALL AND FOR MINORS COMMITTED TO CAMP TO RECOVER THE COST OF FOOD, CLOTHING, PERSONAL SUPPLIES, AND ALLOWABLE MEDICAL SERVICES." AND WE HAVE NO WRITTEN PROTESTS, MR. CHAIRMAN. 

SUP. KNABE, CHAIR: OKAY. OPEN THE PUBLIC HEARING. SEEING NO ONE, WE'LL MOVE THAT THE PUBLIC HEARING BE CLOSED. MOVED BY SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR BURKE. WITHOUT OBJECTION, SO ORDERED. ITEM 77. 

CLERK VARONA-LUKENS: "HEARING ON PROPOSED AMENDMENTS TO TITLE 8, CONSUMER PROTECTION AND BUSINESS REGULATIONS AND TITLE 20, UTILITIES, TO IMPOSE AN INCREASE BY 5% FOR MOST PUBLIC HEALTH LICENSE AND PERMIT FEES, ALLOWING THE DEPARTMENT OF HEALTH SERVICES, ENVIRONMENTAL HEALTH PROGRAM, TO RECOVER COSTS AND TO ADD ADDITIONAL TIERS TO THE DEPARTMENT OF HEALTH SERVICES FEE STRUCTURE." WE HAVE NO WRITTEN PROTESTS, MR. CHAIRMAN. 

SUP. KNABE, CHAIR: WELL, I THINK YOU DID HAVE A LETTER OF PROTEST FROM THE RESTAURANT ASSOCIATION. OBVIOUSLY, I WAS THE ONE THAT CONTINUED THIS ITEM UNTIL DISCUSSIONS TOOK PLACE WITH THE VARIOUS ASSOCIATIONS. IT APPEARS THAT SOME ARE REASONABLE BUT, AS I INDICATED LAST YEAR, AFTER THREE CONSECUTIVE YEARS, THAT I WAS HAVING A HARD TIME WITH THE RESTAURANT ASSOCIATION INCREASING FEES AND, WITH THIS RECOMMENDED INCREASE, THAT WOULD BE 30% OVER THE LAST THREE YEARS HAVE IMPACTED THE ASSOCIATION. SO I'M JUST GOING TO ASK THAT IT BE RECORDED THAT I AM VOTING "NO" ON SECTION 8.04.720, WHICH IS THE PROPOSED INCREASE TO RESTAURANT INSPECTION FEES. AND, WITH THAT, MOVED BY SUPERVISOR MOLINA, SECONDED BY SUPERVISOR BURKE. JUST RECORD ME AS A "NO" VOTE. SO ORDERED. I BELIEVE THAT TAKES CARE OF THE AGENDA. YOU WANT TO TAKE US INTO CLOSED SESSION. PUBLIC COMMENT. I'M SORRY. OH, THERE WAS ONE. ROBERT MCCORDIC, COME FORWARD, PLEASE. 

ROBERT MCCORDIC: YES, SIR. 

SUP. KNABE, CHAIR: OKAY. IF YOU'D GO AHEAD, PLEASE. 

ROBERT MCCORDIC: YES. I WANT TO THANK THE COUNTY COUNSEL FOR THE ONE TIME BEFORE WHEN LOS ANGELES POLICE DEPARTMENT STOLE TITLE TO MY APARTMENT BUILDING AND O.J. SIMPSON WENT TO BAT FOR ME AT HIS EXPENSE AND HIS ATTORNEY SHAPIRO SAID I COULD GO BEFORE THIS COUNCIL AND GET THE TITLE BACK. YOU GOT THE TITLE BACK TO ME IN A COUPLE OF MINUTES. THANKS FOR THAT. BUT WE GOT ALSO THE LOS ANGELES POLICE DEPARTMENT FORGED TITLE TO A WILL THAT I HAD FROM MY AUNT JESSE MCGINNIS, VERY SKILLFUL TYPE OF FORGERY. I GOT IT HERE. THE WILL WAS MADE OUT TO ME IN ITS ENTIRETY AND THEY SAID THAT THE MONEY HAD TO GO TO THE RIGHTFUL HEIRS, WHICH WERE MY DAUGHTER AND TWO SISTERS, BUT SOMEHOW OR ANOTHER, ZILCH, NONE OF THE MONEY EVER GOT BACK THERE. THE POLICE STILL GOT IT. SO I WANT THE COUNTY COUNSEL TO GET THAT MILLION DOLLARS IN PROPERTY AND CASH BACK TO ME THE SAME AS YOU DID BEFORE. AND THEN, OVERALL, WHILE I WAS HONORED FOR EXPOSING THE FACT THAT THE LOS ANGELES POLICE DEPARTMENT WAS COMPLETELY CONTROLLED BY THE ISLAMS AND MUSLIMS OF THE MIDDLE EAST, WHEN I EXPOSED THAT FACT, WHY, I WAS CONTACTED BY COLONEL TIBETTS' SECRETARY IMMEDIATELY, AND COLONEL TIBETTS SAID HE WANTED ME TO BE HIS CLOSEST PERSONAL FRIEND AND HE HAD HIS PERSONAL SECRETARY, WHO WAS ALSO AIR FORCE VETERAN, CONTACT ME AND MOVED INTO MY HOME IN GRANADA HILLS WITH A SHOTGUN AND A .357 MAGNUM TO PROTECT ME ON THIS DANGEROUS TYPE OF INFORMATION. NOW, THE JEWS-- THERE WERE JEWS IN THE AIR FORCE AND, SINCE I WAS IN THE AIR FORCE IN WORLD WAR II, WHY, THE JEWS WERE TRYING TO DO EVERYTHING THEY COULD TO MAKE ME A MILLIONAIRE OR MORE SO, SO THEY GOT ME MARRIED TO A JEW GIRL WHO WAS WORTH OVER $500 MILLION. THAT'S NET WORTH NOW BUT THE POLICE DIDN'T LIKE THAT VERY WELL, SO FORCED THE DIVORCE. I DIDN'T DARE TELL HER THAT I WAS WORKING DEEP UNDERGROUND FOR THE F.B.I. IN THE INVESTIGATION OF TREASON IN THE LOS ANGELES POLICE DEPARTMENT AND OTHER DEADLY DANGERS. 

SUP. KNABE, CHAIR: OKAY. THANK YOU. THANK YOU VERY MUCH. 

JOHN MCKIBBEN: CAN I GET MY MONEY BACK? 

SUP. KNABE, CHAIR: WE'LL HAVE SOMEONE FROM COUNTY COUNSEL TALK TO HIM AGAIN. THANK YOU. OKAY. WITH THAT, WE'LL HAVE EXECUTIVE OFFICER TAKE US INTO CLOSED SESSION. 

CLERK VARONA-LUKENS: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION; ITEM CS-2, CONFERENCE WITH LEGAL COUNSEL REGARDING INITIATION OF LITIGATION, ONE CASE, AND ITEM CS-3, CONFERENCE WITH REAL PROPERTY NEGOTIATORS, DAVID E. JANSSEN, STAN WISNIEWSKI AND RICHARD VOLPERT WITH RESPECT TO A PROPOSED NEW LEASE AND PROPOSED LEASE EXTENSION FOR PROPERTIES WITHIN THE MARINA DEL RAY SMALL CRAFT HARBOR, AS INDICATED ON THE POSTED AGENDA. THANK YOU. 

REPORT OF ACTION TAKEN IN CLOSED SESSION ON AUGUST 17, 2004 

The Board of Supervisors met today in Closed Session. The following action is being reported: 

CS-2. CONFERENCE WITH LEGAL COUNSEL -  ANTICIPATED LITIGATION (Subdivision (c) of Government Code Section 54956.9) Initiation of litigation (one case) 

Action Taken: 

The Board of Supervisors authorized its legal counsel to initiate an action. Once formally commenced, the action, parties and other particulars will be disclosed to any person upon inquiry. 

The vote of the Board was: 

Supervisor Molina: Aye 

Supervisor Burke: Aye 

Supervisor Yaroslavsky: Aye 

Supervisor Antonovich: Absent 

Supervisor Knabe: Aye 
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